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Introduction
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Purpose

Purpose
The Class 6 M-Style SmartMotor™ Installation and Startup Guide (the document you are currently
reading) provides an overview of the Class 6 M-Style SmartMotor, along with information on unpacking,
installation and start up. This guide is meant to be used in conjunction with the SmartMotor™
Developer's Guide, which describes the SmartMotor features, SMI software, programming, commands,
and other topics related to SmartMotor application development.

NOTE: The guide applies to all Class 6 M-style motors (see the next figure). However, some
features/functions described in this guide apply only to Class 6 MT2 motors.

Class 6 MT (Left) vs. MT2 (Right)

The information in this guide is meant to be used by properly trained technical personnel only. Moog
Animatics conducts classroom-style SmartMotor training several times per year, as well as product
seminars and other training opportunities. For more information, please see the Moog Animatics
website or contact your Moog Animatics representative.

Combitronic Technology
NOTE: Combitronic over Ethernet requires the -EIP option Class 6 M-style SmartMotor with the
netX 52 processor, NXF EIP version 3.4.0.5 or later, and SmartMotor firmware 6.0.2.35 or later.

The most unique feature of the SmartMotor is its ability to communicate with other Class 6 M-style
SmartMotors and share resources using Moog Animatics’ Combitronic™ technology. Combitronic is a
protocol that typically operates over a standard CAN interface. However, in the case of the Class 6
SmartMotor, it operates over Ethernet. In other words, the user commands that are supported through
Combitronic over CANopen are just shifted to Ethernet. For example, the RPA command and many
others are supported, as well as the PTS family of commands. Combitronic over Ethernet requires no
single dedicated controller1 to operate. Each SmartMotor connected to the same network
communicates on an equal footing, sharing all information, and therefore, sharing all processing
resources.

For additional details, see the SmartMotor™ Developer's Guide.

1Moog Animatics has replaced the terms "master" and "slave" with "controller" and "follower",
respectively.
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Safety Information

Safety Information
This section describes the safety symbols and other safety information.

Safety Symbols
The manual may use one or more of these safety symbols:

WARNING: This symbol indicates a potentially nonlethal mechanical hazard, where
failure to comply with the instructions could result in serious injury to the operator
or major damage to the equipment.

CAUTION: This symbol indicates a potentially minor hazard, where failure to
comply with the instructions could result in slight injury to the operator or minor
damage to the equipment.

NOTE: Notes are used to emphasize non-safety concepts or related information.

Other Safety Considerations
The Moog Animatics SmartMotors are supplied as components that are intended for use in an
automated machine or system. As such, it is beyond the scope of this manual to attempt to cover all
the safety standards and considerations that are part of the overall machine/system design and
manufacturing safety. Therefore, this information is intended to be used only as a general guideline for
the machine/system designer.

It is the responsibility of the machine/system designer to perform a thorough "Risk Assessment" and to
ensure that the machine/system and its safeguards comply with the safety standards specified by the
governing authority (for example, ISO, OSHA, UL, etc.) for the site where the machine is being installed
and operated. For more details, see Machine Safety on page 9.

Motor Sizing

It is the responsibility of the machine/system designer to select SmartMotors that are properly sized
for the specific application. Undersized motors may: perform poorly, cause excessive downtime or
cause unsafe operating conditions by not being able to handle the loads placed on them. The System
Best Practices document, which is available on the Moog Animatics website, contains information and
equations that can be used for selecting the appropriate motor for the application.

Replacement motors must have the same specifications and firmware version used in the approved and
validated system. Specification changes or firmware upgrades require the approval of the system
designer and may require another Risk Assessment.

Environmental Considerations

It is the responsibility of the machine/system designer to evaluate the intended operating environment
for dust, high-humidity or presence of water (for example, a food-processing environment that requires
water or steam wash down of equipment), corrosives or chemicals that may come in contact with the
machine, etc. Moog Animatics manufactures specialized IP-rated motors for operating in extreme
conditions. For details, see the Moog Animatics Product Catalog.
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Machine Safety

Machine Safety

In order to protect personnel from any safety hazards in the machine or system, the machine/system
builder must perform a "Risk Assessment", which is often based on the ISO 13849 standard. The
design/implementation of barriers, emergency stop (E-stop) mechanisms and other safeguards will be
driven by the Risk Assessment and the safety standards specified by the governing authority (for
example, ISO, OSHA, UL, etc.) for the site where the machine is being installed and operated. The
methodology and details of such an assessment are beyond the scope of this manual. However, there
are various sources of Risk Assessment information available in print and on the internet.

NOTE: The next list is an example of items that would be evaluated when performing the Risk
Assessment. Additional items may be required. The safeguards must ensure the safety of all
personnel who may come in contact with or be in the vicinity of the machine.

In general, the machine/system safeguards must:
l Provide a barrier to prevent unauthorized entry or access to the machine or system. The barrier
must be designed so that personnel cannot reach into any identified danger zones.

l Position the control panel so that it is outside the barrier area but located for an unrestricted
view of the moving mechanism. The control panel must include an E-stop mechanism. Buttons
that start the machine must be protected from accidental activation.

l Provide E-stop mechanisms located at the control panel and at other points around the
perimeter of the barrier that will stop all machine movement when tripped.

l Provide appropriate sensors and interlocks on gates or other points of entry into the protected
zone that will stop all machine movement when tripped.

l Ensure that if a portable control/programming device is supplied (for example, a hand-held
operator/programmer pendant), the device is equipped with an E-stop mechanism.

NOTE: A portable operation/programming device requires many additional system design
considerations and safeguards beyond those listed in this section. For details, see the safety
standards specified by the governing authority (for example, ISO, OSHA, UL, etc.) for the site
where the machine is being installed and operated.

l Prevent contact with moving mechanisms (for example, arms, gears, belts, pulleys, tooling, etc.).

l Prevent contact with a part that is thrown from the machine tooling or other part-handling
equipment.

l Prevent contact with any electrical, hydraulic, pneumatic, thermal, chemical or other hazards that
may be present at the machine.

l Prevent unauthorized access to wiring and power-supply cabinets, electrical boxes, etc.

l Provide a proper control system, program logic and error checking to ensure the safety of all
personnel and equipment (for example, to prevent a run-away condition). The control system
must be designed so that it does not automatically restart the machine/system after a power
failure.

l Prevent unauthorized access or changes to the control system or software.

Documentation and Training

It is the responsibility of the machine/system designer to provide documentation on safety, operation,
maintenance and programming, along with training for all machine operators, maintenance technicians,
programmers, and other personnel who may have access to the machine. This documentation must
include proper lockout/tagout procedures for maintenance and programming operations.
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Additional Equipment and Considerations

It is the responsibility of the operating company to ensure that:
l All operators, maintenance technicians, programmers and other personnel are tested and
qualified before acquiring access to the machine or system.

l The above personnel perform their assigned functions in a responsible and safe manner to
comply with the procedures in the supplied documentation and the company safety practices.

l The equipment is maintained as described in the documentation and training supplied by the
machine/system designer.

Additional Equipment and Considerations

The Risk Assessment and the operating company's standard safety policies will dictate the need for
additional equipment. In general, it is the responsibility of the operating company to ensure that:

l Unauthorized access to the machine is prevented at all times.

l The personnel are supplied with the proper equipment for the environment and their job
functions, which may include: safety glasses, hearing protection, safety footwear, smocks or
aprons, gloves, hard hats and other protective gear.

l The work area is equipped with proper safety equipment such as first aid equipment, fire
suppression equipment, emergency eye wash and full-body wash stations, etc.

l There are no modifications made to the machine or system without proper engineering
evaluation for design, safety, reliability, etc., and a Risk Assessment.

Safety Information Resources
Additional SmartMotor safety information can be found on the Moog Animatics website; open the topic
"Controls - Notes and Cautions" located at:

https://www.animatics.com/support/downloads/knowledgebase/controls---notes-and-cautions.html

OSHA standards information can be found at:

https://www.osha.gov/law-regs.html

ANSI-RIA robotic safety information can be found at:

http://www.robotics.org/robotic-content.cfm/Robotics/Safety-Compliance/id/23

UL standards information can be found at:

http://ulstandards.ul.com/standards-catalog/

ISO standards information can be found at:

http://www.iso.org/iso/home/standards.htm

EU standards information can be found at:

http://ec.europa.eu/growth/single-market/european-standards/harmonised-standards/index_en.htm
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Additional Documents

Additional Documents
The Moog Animatics website contains additional documents that are related to the information in this
manual. Please refer to these lists.

Related Guides
l SmartMotor™ Developer's Guide

http://www.animatics.com/smartmotor-developers-guide

l SmartMotor™ Homing Procedures and Methods Application Note

http://www.animatics.com/homing-application-note

l SmartMotor™ System Best Practices Application Note

http://www.animatics.com/system-best-practices-application-note

In addition to the documents listed above, guides for fieldbus protocols and more can be found on the
website: https://www.animatics.com/support/downloads.manuals.html

Other Documents
l SmartMotor™ Certifications

https://www.animatics.com/certifications.html

l SmartMotor Developer's Worksheet
(interactive tools to assist developer: Scale Factor Calculator, Status Words, CAN Port Status,
Serial Port Status, RMODE Decoder and Syntax Error Codes)

https://www.animatics.com/support/downloads.knowledgebase.html

l Moog Animatics Product Catalog

http://www.animatics.com/support/moog-animatics-catalog.html
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Additional Resources

Additional Resources
The Moog Animatics website contains useful resources such as product information, documentation,
product support and more. Please refer to these addresses:

l General company information:

http://www.animatics.com

l Product information:

http://www.animatics.com/products.html

l Product support (Downloads, How-to Videos, Forums and more):

http://www.animatics.com/support.html

l Contact information, distributor locator tool, inquiries:

https://www.animatics.com/contact-us.html

l Applications (Application Notes and Case Studies):

http://www.animatics.com/applications.html
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SmartMotor Overview

SmartMotor Overview
This chapter provides an overview of the design philosophy and functionality of the Moog Animatics
SmartMotor. It also provides information on SmartMotor features and options, and where to find
related documents and additional resources.
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SmartMotor Introduction

SmartMotor Introduction
The Moog Animatics SmartMotor™ servo is an industrial servo motor with motion controller integrated
into a compact package. Its design is based on these objectives:

1. Reduce development time

2. Lower machine-production cost

3. Simplify the machine (design, build and support)

Class 6 M-Style MT SmartMotor (23-Frame)

Class 6 M-Style MT2 SmartMotor (34- and 23-Frame)

The SmartMotor is powerful and unique because of its ability to control an entire machine. The
combination of programmability, networking, I/O and servo performance is unmatched. The SmartMotor
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SmartMotor Features and Options

brings savings and value to the machine builder by removing complex and costly elements in the
machine design, such as PLCs, sensors, I/O blocks, cabinets, etc.

SmartMotor Features and Options
NOTE: All specifications are subject to change without notice. Consult the factory for the latest
information.

All SmartMotors offer these features:
l Full floating-point math and trigonometric functions with 32-bit precision results

l Dual trajectory generators enabling relative and absolute position moves or velocity moves on
top of gearing or camming

l Advanced gearing allowing preset traverse and take-up winding parameters including dwells and
wrap counts

l Advanced camming including cubic spline interpolation and dynamic frequency and amplitude
changes. Add onto gearing for complex traverse and take-up winding patterns.

l Stand-alone, multi-axis linear interpolation with as many as 120 SmartMotors at a time

l Virtual-axis control into camming through gearing, which enables stand-alone, multi-axis
coordinated motion

l Programmable and non-programmable protection features (both hardware and software)

A note about SmartMotor part numbers:

The SmartMotor uses a coded part number, which contains characters that describe the motor number,
frame style and options. For details on decoding the SmartMotor part number, refer to the
Understanding SmartMotor Part Numbers document at this address:

https://www.animatics.com/support/downloads.knowledgebase.html

Class 6 M-Style Motors
The Class 6 SmartMotor is available in an M-style configuration.

Standard Features

All Class 6 M-style SmartMotors have these standard features:
l Two-port Industrial Ethernet (IE), IEEE 1588 capable, for extremely accurate motion
synchronization

l LEDs: Bi-colored LED indicators to show error codes, provide network status and
communications activity

l Communications: RS-485, micro USB, Combitronic over Ethernet (on properly configured motors,
see Note) and Industrial Ethernet

NOTE: Combitronic over Ethernet requires the -EIP option Class 6 M-style SmartMotor with the
netX 52 processor, NXF EIP version 3.4.0.5 or later, and SmartMotor firmware 6.0.2.35 or later.

l SMI software available, optionally used for application development and debugging

l I/O support for Drive Enable, Position Limits and Fault status

l Motor sample rate: 16 kHz
l Position Capture Register from signal-ended, ground-referenced external input (non-differential)
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Optional Features

l External encoder input supporting either A-quad-B or Step-and-Direction modes of counting
l Machine Line Shaft Input support

l Maximum individual line frequency at either the A or B input is 1.5 MHz

All firmware options include:
l Modbus Remote Terminal Unit (RTU) Follower (RS-485 COM 0), see the SmartMotor™ Modbus
RTU Guide

l DMX Follower (RS-485 COM 0), see the SmartMotor™ DMX Guide

Optional Features

These features are only available on the MT2 Class 6 M-style SmartMotors:
l microSD card added on MT2 motors supports program storage and loading application-specific
parameters

l Two outputs added on MT2 motors, 24V I/O connector, pins 5 and 6 (IN/OUT4 GP and IN/OUT5
GP, respectively)

l Internal brake is available on MT2 motors

l IP sealing is available on MT2 motors (IP level varies based on other options ordered)

These fieldbus communications protocols are available on the Class 6 motors. (Availability varies by
model number; see the Moog Animatics Product Catalog for details.)

l EtherNet/IP (-EIP) option

l EtherCAT (-EEC) option

l PROFINET (-EPN) option

The Class 6 M-style motors are available in these NEMA frame sizes:
l NEMA 23 (MT and MT2)

l NEMA 34 (MT2 only)

For additional information on SmartMotor features, specifications, torque curves and more, see the
corresponding SmartMotor product page for your motor. SmartMotor product pages are available from
the Products menu on the Moog Animatics website.

Connectors and LED Locations

The next figure shows the connector and LED location for the Class 6 M-style SmartMotor. Note that
connector and LED positions are the same on MT and MT2 motors. For details on the motor connectors,
see Connecting the System on page 30. For details on the LED functions, see Understanding the Status
LEDs on page 37.
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Connectors and LED Locations

LED 2: (Network specific**)

LED 0: Motor Drive LED

LED 5: Link LED

LED 3: (Network specific**)

LED 1: Motor Busy LED

LED 4: Link LED

Power Input

CommunicationI/O

Industrial Ethernet

USB Active LED

**Refer to the Status LED description in the corresponding SmartMotor fieldbus guide

SD Card LED

(if equipped)

Micro USB and microSD slot on some models

LED 2: (Network specific**)

LED 0: Motor Drive LED

LED 5: Link LED

LED 3: (Network specific**)

LED 1: Motor Busy LED

LED 4: Link LED

Power Input

CommunicationI/O

Industrial Ethernet

USB Active LED

**Refer to the Status LED description in the corresponding SmartMotor fieldbus guide

SD Card LED

Micro USB and microSD slot

Class 6 M-Style MT and MT2 SmartMotor Connectors and LEDs

CAUTION: When daisy-chaining multiple SmartMotor servos for an EtherCAT
network, you must connect the OUT port (right-hand port) of the upstream motor
to the IN port (left-hand port) of the downstream motor.
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Fieldbus Options

Fieldbus Options
This section details the Fieldbus communications protocol options that are available on SmartMotors.

EtherCAT Fieldbus Protocol

NOTE: This fieldbus protocol is optionally available on Class 6 M-style motors.

The EtherCAT fieldbus protocol provides these features:
l Command/Response Codes for SmartMotor commands

l CiA 402 Motion Modes: Profile Position (PP), Profile Velocity (PV), Torque (TQ), Cyclic Sync
Position (CSP), Cyclic Sync Velocity (CSV), Cyclic Sync Torque (CST)

l Dynamic PDO mapping

l Configurable Sync Manager 2 and 3 assignment

l DC-sync Subordinate mode with SYNC0 and SYNC1

l DC-sync follower

l Selectable Homing modes (with or without index pulse)

l Selectable Interpolation modes (spline or linear)

l Touch Probe function allows the motor's position to be captured on a specific event

For the EtherCAT connector diagram and pinouts, see Connecting the System on page 30.

For more details, see the Class 6 SmartMotor EtherCAT Guide.

PROFINET Fieldbus Protocol

NOTE: This fieldbus protocol is optionally available on Class 6 M-style motors.

The PROFINET fieldbus protocol provides these features:
l Command/response codes for SmartMotor commands

l Use of on-board I/O through PROFINET, SmartMotor program, or RS-485 commands

l The Moog Animatics communications profile over PROFINET is intended to integrate well with a
PLC that continuously transmits and receives cyclic data; the command and response codes
achieve this through a handshaking mechanism

For the PROFINET connector diagram and pinouts, see Connecting the System on page 30.

For more details, see the Class 6 SmartMotor™ PROFINET Guide.

EtherNet/IP Fieldbus Protocol

NOTE: This fieldbus protocol is optionally available on Class 6 M-style motors.

The EtherNet/IP fieldbus protocol provides these features:
l Access to unique SmartMotor commands and parameters.

l Use of on-board I/O through EtherNet/IP, SmartMotor program, or RS-485 commands
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SmartMotor Theory of Operation

l The Moog Animatics communications profile over EtherNet/IP is intended to integrate well with
a PLC that continuously transmits and receives cyclic data (implicit messaging); the command
and response codes achieve this through a handshaking mechanism

l Certain configuration data is held in nonvolatile storage in the SmartMotor; therefore, the motor
data EEPROM must be correctly initialized before EtherNet/IP operation

l Supports extended function CIP Position Controller Device

l Supports Combitronic over Ethernet

NOTE: Combitronic over Ethernet requires the -EIP option Class 6 M-style SmartMotor with
the netX 52 processor, NXF EIP version 3.4.0.5 or later, and SmartMotor firmware 6.0.2.35 or
later.

l Supports Modbus TCP/IP, see the Class 6 SmartMotor™ Modbus TCP/IP Guide

l Supports Ethernet Serial Encapsulation, see the Class 6 SmartMotor Ethernet Serial
Encapsulation Guide

l Control modes for Profile Torque, Profile Velocity and Profile Position modes

l Change Dynamic – motion profile changes on the fly

l Implicit exchange access to many SmartMotor parameters

l Supports the SMI software Find/Detect operations over Ethernet — the SmartMotor must be
previously configured (through COM or USB) with a valid IP address

For the EtherNet/IP connector diagram and pinouts, see Connecting the System on page 30.

For more details, see the Class 6 SmartMotor EtherNet/IP Guide.

SmartMotor Theory of Operation
The Moog Animatics SmartMotor is an entire servo control system built inside of a servo motor. It
includes a controller, an amplifier and an encoder. All that is required for it to operate is power and
either an internal program or serial commands from outside (or both). To make the SmartMotor move,
the program or serial host must set a mode of operation, state a target position with/or a maximum
velocity at which to travel to that target, and a maximum acceleration. After these three parameters
are set, the two limit inputs are pulled high or deactivated, and the Drive Enable input is satisfied, a
"Go" command starts the motion profile.

The core functional areas of the SmartMotor are:
l Motion Control Functions (see Motion Details in the SmartMotor™ Developer's Guide)

l System Control Functions (see Program Flow Details and see System Status in the SmartMotor™
Developer's Guide)

l Communication Functions (see Communication Details in the SmartMotor™ Developer's Guide)

l I/O Functions (see I/O Control in the SmartMotor™ Developer's Guide)
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SmartMotor Theory of Operation

The next block diagram illustrates the relationship between the functional areas in the SmartMotor.
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1.  MFMUL and MFDIV commands do not have an e!ect on  dwell time or distance.  Dwell is strictly based on  raw controller encoder counts selected by the 

SRC( ) command  specifying internal virtual or external controller count source.

2.  When feeding a Cam table with a gearing pro"le, changes to MFMUL and MFDIV will a!ect the time it takes to move through a Cam table but will not 
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Getting Started

Getting Started
This chapter provides information on getting started with your SmartMotor.

Unpacking and Verifying Your Shipment 23
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Installation Procedure 23

Installation Verification 26
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Moog Animatics Industrial Ethernet Cables 35

M-style to M-style Ethernet Cable 35

M-style to RJ45 Ethernet Cable 35
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Understanding the Status LEDs 37
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Getting Started

Detecting and Communicating with the SmartMotors 40

Understanding the Detection and Configuration Options 40

Using the Find Motors Button 40

Using the Detect Motors Feature 43

Checking and Clearing the Status Bits 45

Polling the Motor 46

Clearing the Overtravel Limits and Fault Bits 47

Moving the SmartMotor 48

Making the Motor Move 48

Setting and Reporting Torque 49

Checking the Motor Position 50

Viewing the Motor Position with a Report Command 50

Viewing the Motor Position with the Motor View Tool 50
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Unpacking and Verifying Your Shipment

Unpacking and Verifying Your Shipment
Your Moog Animatics SmartMotor and accessories are carefully assembled, tested, inspected and
packed at the factory.

When you receive your shipment, you should:
l Visually inspect all shipping containers for visible signs of shipping damage. If you see damage,
please notify your carrier and then contact Moog Animatics to report the problem.

l Carefully unpack each component and verify the part number with your order. If there are any
differences or missing items, please contact Moog Animatics so that the shipment can be
corrected.

l Keep all boxes and packing materials. These may be needed for future storage or shipment of
the equipment.

Installing the SMI Software
The SmartMotor Interface software (SMI software) provides a convenient user interface for
programming the SmartMotor. Before you can use the SMI software, it must be installed on a Microsoft
Windows PC.

The SMI software is distributed on CD-ROM or USB stick, and is also available as a download from the
Moog Animatics website. To download the latest version of the SMI software, use this address:

http://www.animatics.com/smi

Then scroll to the bottom of the page and click the Free Download button.

SMI Download Button

The installation package is downloaded to your system.

NOTE: The SMI software requires Microsoft Windows XP or later.

Installation Procedure
NOTE: Depending on the SMI software version and SmartMotor model being used, the software
version and motor information may be different on your screens.

To install the SMI software:
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Installation Procedure

1. Double-click the executable package (.MSI) file to begin the installation. In some versions of
Microsoft Windows, you may receive a security warning message about running the file. You can
ignore this message.

If this is a new installation, go to the next step.

If this is an upgrade to a previous installation, you will see the window below. Select Remove,
click Next and remove the existing software from your PC using the instructions.

After removing the existing software, restart the installation process.

NOTE: All personal settings and user files will be retained.
2. Click Next to proceed. The Installation Configuration page opens.
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Installation Procedure

3. Click Next to proceed. The SMI software installation wizard starts and the Welcome page opens.

4. After you have finished reviewing the welcome information, click Next to proceed. Use the on-
screen instructions to complete the SMI software installation.
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Installation Verification

5. When the installation has completed, the installation status message page opens, as shown in
the next figure. Click Finish to complete the installation and close the installation wizard.

NOTE: After the software is installed, be sure to restart your computer before running the SMI
software.

Installation Verification
To verify the installation, navigate to the C:\Program Files (or folder C:\Program Files x86) folder. You
should see these folders:

Accessing the SMI Software Interface
The SmartMotor Interface software (SMI software) communicates with a single or series of
SmartMotors from a Windows-based PC and gives you the capability to control and monitor the status
of the motors. The SMI software also allows you to write programs and download them into the
SmartMotor’s long-term memory.

NOTE: Every SmartMotor has an ASCII interpreter built in. Therefore, it is not necessary to use the
SMI software to operate a SmartMotor.

To open the SMI software, double-click the SmartMotor Interface shortcut on the Windows desktop.

SmartMotor Interface Shortcut
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Accessing the SMI Software Interface

Optionally, to open the SMI software from the Microsoft Windows Start menu, select:

Start > All Programs > Animatics > SMI3 > SmartMotor Interface

The SMI software interface opens, as shown in the next figure.

Menu bar

Toolbar

Con!guration
window

Terminal
window

Information
window

Program
editor

SMI Software Interface

NOTE: In addition to the software information in this section, there is context-sensitive help
available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

These are the primary features in this interface:
l Menu Bar: All of the windows and functions of the SMI software can be accessed through the
menu bar. Many of these are also accessible through the icons on the toolbar.

l Toolbar: The toolbar contains a collection of icons for accessing the primary features of the SMI
software. Depending on the current state of the SMI software and the currently-active window,
some toolbar buttons may be disabled.

l Configuration Window (far-left window): This window is used to display the current
communication and detected motor configuration when no project is open, or the communication
and motor configuration defined in an open project.

l Terminal Window (middle window): This window is used to communicate with SmartMotors (for
example, issue single-line commands to one or all motors). The response (if any) is also shown in
this window.

l Information Window (lower window): This window is used to display the results of user
operations.

l Program Editor (far-right window): This window is used to manage, edit and print user programs.
Most of the procedures for using the editor should seem familiar if you have used other
Windows-based text editors.

For more details about these items, see the SMI software online help, which can be viewed in SMI by
pressing F1 or selecting Help > Contents - SMI Software Help.
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Understanding the Power Requirements

Understanding the Power Requirements
This section describes the power requirements for Class 6 M-style SmartMotor power, CPU power, I/O
power and Communications power.

SmartMotor Power Requirements

CAUTION: If power is reversed on any standard SmartMotor, immediate damage
WILL occur and the SmartMotor will no longer operate.

Requirement:
For Class 6 M-style SmartMotors:

CAUTION: Control power for Class 6 M-style motors must be nominal 24 VDC
(±20%). They are not rated for 48 VDC.

Control power requires nominal 24 VDC (±20%), do not exceed 32 VDC; motor power requires from 24
VDC to 48 VDC, do not exceed 48 VDC.

Details: Large SmartMotors can draw high current. Therefore, heavy gauge wire is required to connect
the large motors.

Voltages below 18 VDC could cause a brownout shutdown of the CPU, or what would appear as a
power-off reset, under sudden load changes.

When relying on torque/speed curves, pay close attention to the voltage on which they are based.

During hard, fast decelerations, a SmartMotor can pull up supply voltages to the point of damage if a
shunt resistor pack is not used. Protective shunts are available from Moog Animatics.

CAUTION: Many vertical applications and applications with hard, fast
decelerations require shunts to protect the SmartMotor from damage. Note that
shunts should always be placed between the motor input and any disconnect or E-
stop relay to protect the motor when power is off or E-stop relay contacts are
open.

Special care must be taken when near the upper voltage limit or in vertical applications that can back-
drive the SmartMotor. Gravity-influenced applications can turn the SmartMotor into a generator and
back-drive the power supply voltage above the safe limit for the SmartMotor. Many vertical
applications require a shunt to protect the SmartMotor from damage. Protective shunts are available
from Moog Animatics.

CPU, I/O and Communications Power

CAUTION: The maximum allowed supply voltage is 32 VDC. Voltages greater than
the maximum value will damage the equipment.

CPU Power Requirements

Requirement: Nominal 24 VDC (±20%)must be supplied. Do not exceed 32 VDC.

Details: Power is supplied from the "control" power input (pin 1) on the 4-pin power input connector.
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I/O Power Requirements

I/O Power Requirements

Requirement: Nominal 24 VDC (±20%) must be supplied. Do not exceed 32 VDC.

Details: Power is supplied from the "control" power input (pin 1) on the 4-pin power input connector.

NOTE: This I/O is not isolated from the CPU's power supply and the motor drive.

24 VDC Control/IO output power is provided on pin 11 and supports a maximum of 2 amps. That pin is
directly connected to Pin 1 of the power input connector. Refer to Motor Connectors and Pinouts on
page 31.

Specifications:
NOTE: All specifications assume nominal 24 VDC (±20%) Control power. The maximum allowed
supply voltage is 32 VDC. Voltages greater than the maximum value will damage the motor.

Input Pins Electrical Specification:

l Input Voltage Low Level Threshold: 3.6 V maximum
l Input Voltage High Level Threshold: 5.0 V minimum
l Input Hysteresis Voltage: 1.0 V minimum

Output Pins Electrical Specification:

l Output Loading:
l Nominal load: 250 mA each
l Maximum load: not to exceed 500 mA total (all outputs combined)

l Output voltage: 23 V maximum load

Communications Power Requirements

Requirement: Nominal 24 VDC (±20%) must be supplied. Do not exceed 32 VDC.

Details: Power is supplied from the "control" power input (pin 1) on the 4-pin power input connector.

NOTE: The RS-485 signal is not isolated from the CPU's power supply or the motor drive.

Drive Enable Input
The Drive Enable input (P3, pin 8) must be connected and activated with 24V. For the input location,
see Motor Connectors and Pinouts on page 31.
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Connecting the System

Connecting the System
The next sections show system connections and cable diagrams for typical installations. For connector
specifications and example I/O connections, see Connectors, Pinouts and Examples on page 52.

Minimum Requirements
At minimum, you will need these items:

1. A Class 6 M-style SmartMotor

2. A computer running Microsoft Windows and the SMI software

3. An I/O cable used to satisfy the Drive Enable input and position limits.

4. A DC power supply and power cable for the SmartMotor

5. A data cable to connect from the computer to the SmartMotor using one of these:
l Serial port (or serial adapter)

l USB port

l Ethernet port

Refer to the next sections for more details.
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Motor Connectors and Pinouts

Motor Connectors and Pinouts
The next figure provides an overview of the connectors and pinouts available on the Class 6
SmartMotor. Note that connector and LED positions are the same on MT and MT2 motors. Additional
connector specs are shown in Class 6 M-Style Connector Pinouts on page 53.

NOTE: In the next figure, I/O pins 5 and 6 OUTPUTS apply to MT2 motors only.

1

2 3

4
POWER INPUT

PIN FUNCTION DESCRIPTION

1 24 VDC CONTROL I/O POWER
2 EARTH CHASSIS GROUND
3 GND MOTOR COMMON GROUND
4 48 VDC MOTOR POWER

COMMUNICATION

PIN FUNCTION

1   GND-COMMON
2   RS-485B CH0
3   RS-485A CH0
4   ENC  A+ (IN/OUT)
5   ENC  B- (IN/OUT)
6   ENC  A- (IN/OUT)
7   5 VDC OUT
8   ENC  B+ (IN/OUT)

1

2

3

4

5

6

7

8

1

2
3

4

5

6
7

8

9

10

11

12

I/Os

PIN FUNCTION DEFAULT

1   IN0   GENERAL PURPOSE
2   IN1   GENERAL PURPOSE
3   IN2/POSLIMIT   POSITIVE LIMIT
4   IN3/NEGLIMIT   NEGATIVE LIMIT
5   IN/OUT4   GENERAL PURPOSE

6   IN/OUT5   GENERAL PURPOSE

7   IN6   GENERAL PURPOSE

8   IN7-DRVEN   DRIVE ENABLE
9   OUT8/BRAKE   BRAKE OUTPUT
10   OUT9-NOFAULT   NOT FAULT
11   24 VDC OUT*   CONTROL I/O POWER
12   GND   MOTOR COMMON GROUND

INPUT OR OUTPUT

  INPUT

POSSIBLE (SELECTABLE) FUNCTIONS

  INPUT
  INPUT
  INPUT
  INPUT/OUTPUT

  INPUT/OUTPUT

  INPUT

  INPUT
  OUTPUT
  OUTPUT
  POWER OUTPUT**
  N/A

  GENERAL PURPOSE, ALSO ANALOG
  GENERAL PURPOSE, ALSO ANALOG
  POSITIVE LIMIT OR GENERAL PURPOSE

  NEGATIVE LIMIT OR GENERAL PURPOSE
  GENERAL PURPOSE, OR EXTERNAL ENCODER 
  INDEX CAPTURE
  GENERAL PURPOSE, OR INTERNAL ENCODER
  INDEX CAPTURE
  GENERAL PURPOSE, G COMMAND, OR 
  HOMING INPUT

  N/A

  NOT FAULT
  BRAKE OUTPUT OR GENERAL-PURPOSE OUTPUT
  DRIVE ENABLE

*NOTE: 2 AMPS MAX   **SUPPLIED FROM POWER INPUT PIN 1

  CONTROL I/O POWER

RS-485 serial communication uses a 
voltage differential signal. Appropriate 
terminating resistors should be included 
on the RS-485 network to ensure reliable 
performance. For details, see the section
Power and RS-485 Com Multidrop.

1

2

3 4

Shield tied to motor
housing

LED 4: Link LED

LED 2: (Network specific**) LED

LED 0: Motor Drive LED

LED 5: Link LED

LED 3: (Network specific**) LED

LED 1: Motor Busy LED

USB Port LED

*The Input/Output applies to these networks. Refer to the following CAUTIONS.

**For LED Status information, refer to the corresponding SmartMotor !eldbus guide.

SD Card LED

EtherNet/IP

PIN FUNCTION

1   +TX
2   +RX
3   -TX
4   -RX

PIN FUNCTION

1   +TD
2   +RD
3   -TD
4   -RD

PROFINET

*Input *Output

EtherCAT*

PIN FUNCTION

1   +TX
2   +RX
3   -TX
4   -RX

CAUTION: M-style connectors must be finger tightened only! DO NOT use a wrench
or other tool. Doing so can cause overtightening of the connection, which may
damage the connector and will void the warranty.

CAUTION: When daisy-chaining SmartMotors for an EtherCAT network, you must
connect the Output port (right-hand port) of the upstream motor to the Input port
(left-hand port) of the downstream motor. For more details, see Connecting the
System on page 30.
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Power and RS-485 Com Multidrop

Power and RS-485 Com Multidrop

NOTE: RS-485 serial communications uses a voltage differential signal that requires proper
termination with a 120 ohm resistor across pins 2 and 3 at both ends of the network cable. This
complies with RS-485 standards for biasing to ensure reliable performance. The termination can be
created by adding the resistor to CBLIP-COM-FL Flying Lead cables or to off-the-shelf connectors.

USB Connector and Cable
As shown in following figure, there is a micro USB (micro-B) connector located under a protective cover
on top of the motor. An LED indicator is also provided, which shows the status/activity for that
connector.

CAUTION: For -IP option (IP sealed) motors, whenever the micro USB/SD cover is
removed, the seal must be inspected and the cover must be reinstalled without
damaging the seal in order to maintain the integrity of the sealed motor.
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USB Connector and Cable

Micro USB Connector Located Under Protective Cover
(34-frame on left, 23-frame on right)

NOTE: To keep dust and debris out of the port, always replace the protective cover when the micro
USB connector is not in use.

A micro-B USB cable is a standard type of USB cable that can be obtained from most computer or
electronics supply stores. Typically, this cable is referred to as a "micro USB" cable.

Micro USB Cable

NOTE: Be aware that some micro USB cables have a thicker plastic molding that may interfere with
the motor housing.
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Industrial Ethernet Network

The next figure shows the SmartMotor connected to a PC through the USB ports on both devices.

USB Connection from PC to SmartMotor

Industrial Ethernet Network
NOTE:   If you have set your PC's network adapter to a fixed IP address for temporary connections
to SmartMotors with SMI, remember to return it to DHCP when done to avoid local area network
connectivity issues.

The Industrial Ethernet network is used for the EtherCAT (-EEC), EtherNet/IP (-EIP) and PROFINET
(-EPN) options. Most Industrial Ethernet (IE) networks support line, tree or star device-connection
topology. Tree or star network may require switches/hubs designed for that network type.
Requirements for specific configurations depend on the capabilities of the controller device, the
follower devices, and use of other networking equipment. For more details, refer to the corresponding
SmartMotor fieldbus manual.

CAUTION: To minimize the possibility of electromagnetic interference (EMI), all
connections should use shielded Ethernet Category 5 (Cat 5), or better, cables. All
interconnecting cables in the daisy chain and/or ring configuration for Industrial
Ethernet must have a length of at least 1 meter (3.28 feet).

The next diagram shows an example Industrial Ethernet network with the SmartMotors daisy chained
to the controller device. A "ring" configuration can be created if the controller device has two ports.

CAUTION: When daisy-chaining SmartMotors for an EtherCAT network, you must
connect the OUT port (right-hand port) of the upstream motor to the IN port
(left-hand port) of the downstream motor. Refer to the Ethernet ports labeling on
your SmartMotor.
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Min and Max Cable Length

Industrial Ethernet Network

Other follower device:

- I/O block,

- Servo drive,

- etc.

Controller device:

- PC,

- PLC,

- etc.

Moog Animatics

Class 6 M-Style

SmartMotor

IN OUT

Moog Animatics

Class 6 M-Style

SmartMotor

IN OUT

*IN/OUT applies only to EtherCAT networks. Refer to the previous CAUTION and motor labeling.

 *  *  *  *

Optional ring for cable redundancy**

**Ring con!guration requires a controller device with two ports

Min and Max Cable Length

The minimum shielded Ethernet Cat 5 cable length between network nodes must be 1 meter.

For transmission speeds of 100 Megabits/second on shielded Ethernet Cat 5 cable, most Industrial
Ethernet networks allow a maximum cable length up to 100 meters between network nodes.

Moog Animatics Industrial Ethernet Cables
The next Industrial Ethernet cables are available from Moog Animatics.

M-style to M-style Ethernet Cable

This cable has M12 male threaded connectors at both ends. It is available in 1, 3, and 5 meter lengths.
For the standard cable, use part number CBLIP-ETH-MM-xM, where "x" denotes the cable length. A
right-angle version may available for certain lengths; see the Moog Animatics website for details.

M-style to RJ45 Ethernet Cable

This cable has an M12 male threaded connector at one end, and an RJ45 male connector at the
opposite end. It is available in 1, 3, and 5 meter lengths. For the standard cable, use part number
CBLIP-ETH-MRJ-xM, where "x" denotes the cable length. See the Moog Animatics website for details.
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Ethernet Cable Schematic

Ethernet Cable Schematic

The next figure provides details for creating a custom Industrial Ethernet shielded cable.

NOTE: The motor end of the cable requires an industrial Ethernet connector.
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Understanding the Status LEDs

Understanding the Status LEDs
This section describes the functionality of the status LEDs on the Class 6 SmartMotor.

Status LEDs
The next figure and tables describe the functionality of the Status LEDs on the SmartMotor. Refer to
the corresponding SmartMotor fieldbus guide for the functions of the network-specific LEDs.

 Off  No power

 Solid green Drive on

 Blinking green  Drive off, no faults

 Triple red flash Watchdog fault

 Solid red  Faulted or no drive enable input

 Off  Not busy
 Solid green Drive on, trajectory in progress

 

  

 

Flashing # red Flashes fault code (see below) 
when Drive LED is solid red

Under cover: 
USB Active LED
SD Card LED (for SD 
Card-equipped motors)

LED 4: Link/Activity LED

LED 2: (Network specific) LED

LED 0: Motor Drive LED

LED 5: Link/Activity LED

LED 3: (Network specific) LED

LED 1: Motor Busy LED

LED 0: Motor Drive LED LED 1: Motor Busy LED

 

 

LED 0 and 1 Status on Power-up:
• With no program and the travel limit inputs are low:

LED 0 solid red; motor in fault state due to travel limit fault     

LED 1 off

• With no program and the travel limits are high:
LED 0 solid red for 500 milliseconds then flashing green 

LED 1 off

• With a program that only disables travel limits: 

LED 0 red for 500 milliseconds then flashing green 

LED 1 off

Flash
1
2
3
4
5
6
7
8
9

10
11

Description
NOT Used
Bus Voltage
Over Current
Excessive Temperature
Excessive Position
Velocity Limit
dE/Dt - First derivative of position error is excessive
Hardware Positive Limit Reached
Hardware Negative Limit Reached
Software Positive Travel Limit Reached
Software Negative Travel Limit Reached 

Fault Codes: pauses for 2 sec before flashing the code 

See the topic “Understanding the SD Card” for details.

Blinking green
 

Busy, do not remove card

Solid green
 

Card detected

Solid red
 

Card with no SmartMotor data

SD Card LED (for SD Card-equipped motors)
No card, bad or damaged cardOff

Alt. red/green In boot load; needs firmware

Flashing green Active

Flashing red  Suspended

Solid red  USB power detected, no 
configuration

USB Active LED

If the USB port is plugged in at power up, it flashes for ~4 
seconds, turns solid red until it is detected through SMI, 
then it returns to flashing

Off  No/bad cable; no/bad Link port

Solid green Link established

Blinking green Activity

LED 5: Link/Activity LED

Off  No/bad cable; no/bad Link port

Solid green Link established

Blinking green Activity

LED 4: Link/Activity LED

Refer to the corresponding SmartMotor 
fieldbus guide

LED 3: (Network specific) LED 

Refer to the corresponding SmartMotor 
fieldbus guide

LED 2: (Network specific) LED
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Understanding the SD Card

Understanding the SD Card
Class 6 MT2 SmartMotor servos are equipped with a microSD card slot. This feature allows the user to
insert a microSD card into the motor, which will then be available for storage of programs, program
parameters, motor configuration, etc.

The remainder of this section discusses specific features and requirements of the microSD card.

SD Card Location and LED Indicator
When viewing the motor from the rear (connector end), the microSD card slot is on top of the motor
under the cover, and the corresponding LED is located on the left side under the cover.

CAUTION: For -IP option (IP sealed) motors, whenever the micro USB/SD cover is
removed, the seal must be inspected and the cover must be reinstalled without
damaging the seal in order to maintain the integrity of the sealed motor.

34-Frame (on left) and 23-Frame (on right)
SD Card and LED Location

LED State Meaning
Off No card, bad card format or damaged card
Green blinking Busy, do not remove card
Green solid Card detected
Red solid Card with no SmartMotor data

SD Card Requirements

CAUTION: All microSD card data must be backed up to a secure storage device.
Moog Animatics is not responsible for loss of data.

The SD card has these requirements:
l Form factor must be a microSD type

l HC and SC cards up to 1 GB are supported
l SC cards over 1 GB are not supported

l Cards should be Class 2 speed or higher
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SD Card Configuration

l Cards must be formatted as Microsoft FAT file system or Microsoft FAT32 file system
l Only SmartMotor files should be placed on the microSD card; all files must be placed in the root
folder

SD Card Configuration
For configuration information, see the topic SD Card Setup in the SMI software online help.

SD Card Operation

CAUTION:
1, Do not insert or remove the card while the motor is powered up. Doing so could
corrupt the card or the motor’s internal EEPROM storage.
2. The file name "program.tmp" is reserved for temporary use. Do not use this file
name on the card.

At start-up time, the motor inspects the microSD card to find the user program executable file. The
motor compares the program on the card to the program stored in the motor. If they differ, then the
program is copied to the motor replacing the program in the motor. After the program is copied to the
motor, the program runs like it would on non-microSD-card motors.

If there was no change because the version on the card matched the version in the motor, the program
will also be run from the motor. Note that:

l Multiple smx files may exist on the card.

l The motor requires that "pointer.txt" exists in the root directory of the card. "pointer.txt"
contains a single line of text with the full file name of the program to run at start-up.

At this time, support for user-configured parameters is limited to SNAME and IDENT, which are stored
on the microSD card as the file "param.ee" in the root of the card’s file system. If this file is present on
the card, the user configuration parameter area in the motor’s internal EEPROM is written with the data
from the microSD card. Note that:

l Network name (SNAME command) saves to the microSD card if it is present.

l IDENT= saves to the microSD card if card is present; RIDENT can report this value; x=IDENT can
recall this value. IDENT is stored as a 32-bit signed value with a default of -1.

SD Card Status Bits
For information on the SD card status bits, see the SmartMotor™ Developer's Guide.
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Detecting and Communicating with the SmartMotors

Detecting and Communicating with the SmartMotors
NOTE: Depending on the SMI software version and SmartMotor model being used, the software
version and motor information may be different on your screens.

This section describes how to detect and address the Class 6 SmartMotor.

This procedure assumes that:
l The SmartMotor is connected to the computer. For details, see Connecting the System on page
30.

l The SmartMotor is connected to a power source. For details, see Understanding the Power
Requirements on page 28 and Connecting the System on page 30.

l The SMI software has been installed and is running on the computer. For details, see Installing
the SMI Software on page 23.

Understanding the Detection and Configuration Options
NOTE: This feature requires connection to the serial (COM) port, configured as RS-485, or the
USB port. EtherNet/IP motors also support the SMI software Find/Detect operations over Ethernet
— the SmartMotor must be previously configured (through COM or USB) with a valid IP address.
There is no support for EtherCAT or PROFINET detection.

There are several ways to use the SMI software to find and address the Class 6 M-style SmartMotors
that are connected to your PC:

l Use the Find Motors button—this method is recommended for first-time communications or
when you don't know the port used to connect the motors. For details, see Using the Find Motors
Button on page 40.

l Use the Detect Motors feature—this method can be used if you know the communications port
used to connect your motors and if your motors may be pre-addressed. For details, see Using the
Detect Motors Feature on page 43.

l To set up your motor to communicate over an Industrial Ethernet (IE) network refer to the
corresponding fieldbus protocol guide.

Several of these methods are described in the next sections.

Using the Find Motors Button
NOTE: For non-EIP motors, Class 6 currently supports SMI Find/Detect operations on RS-485 and
USB connections only. EIP motors additionally support the SMI software Find/Detect operations
over Ethernet — the SmartMotor must be previously configured (through COM or USB) with a valid
IP address.

The easiest way to locate any connected SmartMotor is to use the Find Motors button (see the next
figure). This method searches all ports on the PC for connected motors.

To begin searching for motors on the PC, in the Configuration window of the SMI software interface,
click Find Motors. The SMI software begins searching for all SmartMotors connected to the PC.

NOTE: The next figures show examples for an RS-485 SmartMotor. To see similar example figures
for USB motors, refer to Using the Detect Motors Feature on page 43.
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Using the Find Motors Button

Find Motors Detecting SmartMotors on the RS-485 Chain

After the process has completed, the SMI software shows the found motors in the Configuration
window under the corresponding communications port. Each motor is represented by a motor icon; the
motor's address and firmware version are shown next to the motor icon.

Configuration Window Showing Found/Detected RS-485 SmartMotor

To address the motor, right-click on the motor and select Set Motor Address. For more details, see the
SMI Software Help, which can be accessed within SMI by pressing F1 or from the Help menu.
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Using the Find Motors Button

Motor Menu - Set Motor Address

The motor's detailed information can be viewed in the Motor View window, which is accessed by
selecting the Tools > Motor View > Info tab.

RS-485 Motor View Information
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Using the Detect Motors Feature

Using the Detect Motors Feature
NOTE: For non-EIP motors, Class 6 currently supports SMI Find/Detect operations on RS-485 and
USB connections only. EIP motors additionally support the SMI software Find/Detect operations
over Ethernet — the SmartMotor must be previously configured (through COM or USB) with a valid
IP address.

This method is similar to the Find Motors method, but it searches only the specified communications
port for connected SmartMotors. This is also the recommended method for detecting Class 6 M-style
motors after they have been pre-addressed and daisy-chained to the communications port.

NOTE: The next figures show examples for a USB SmartMotor. To see similar example figures for
RS-485 motors, refer to Using the Find Motors Button on page 40.

To use the Detect Motors feature, in the Configuration window of the SMI software, right-click the
desired communications port and select Detect Motors from the menu.

Selecting the Detect Motors Feature

The SMI software begins searching for all SmartMotors connected to the specified communications
port. A progress bar is shown while the SMI software searches for the motors.

After the process has completed, the SMI software shows the found motors in the Configuration
window under the corresponding communications port. Each motor is represented by a motor icon; the
motor's address and firmware version are shown next to the motor icon.

Configuration Window Showing Found/Detected SmartMotor
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Using the Detect Motors Feature

To address the motor, right-click on the motor and select Set Motor Address. For more details, see the
SMI Software Help, which can be accessed within SMI by pressing F1 or from the Help menu.

Motor Menu - Set Motor Address

The motor's detailed information can be viewed in the Motor View window, which is accessed by
selecting the Tools > Motor View > Info tab.
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Checking and Clearing the Status Bits

Motor View Information

Checking and Clearing the Status Bits
NOTE: In addition to the software information in this section, there is context-sensitive help
available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

The Motor View window is used to view and monitor various motor parameters. It is used in conjunction
with the Terminal window to clear any active overtravel limits.

This procedure assumes that:
l The SmartMotor is connected to the computer. For details, see Connecting the System on page
30.

l The SmartMotor is connected to a power source. For details, see Understanding the Power
Requirements on page 28 and Connecting the System on page 30.

l The SMI software has been installed and is running on the computer. For details, see Installing
the SMI Software on page 23.
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Polling the Motor

l The SmartMotor has been detected and addressed. For details, see Detecting and
Communicating with the SmartMotors on page 40.

Polling the Motor
To view the current state of the status bits, you must poll the motor.

1. Double-click the motor icon to open the Motor View window (see the next figure).

2. Click the Poll button to begin polling data from the motor.

Motor View with Active Overtravel Limits

A SmartMotor with no program and no I/O connections will boot up with active overtravel limits (see
the red status bits numbered 10 through 15 in the previous figure).

The EIGN() command is used to clear these status bits as described in the next section. EIGN stands
for: Enable Inputs as General Use. In the case of EIGN(W,0), the W means a "word" or 16 bits of I/O; the
0 means first word or local I/O. There are only seven local I/O on the D-style motors. Therefore, EIGN
(W,0) sets all seven I/O to general-use inputs.
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Clearing the Overtravel Limits and Fault Bits

Clearing the Overtravel Limits and Fault Bits
To disable (clear) the overtravel limits, enter EIGN(2) and EIGN(3) in the SMI software Terminal
window. This sets I/O 2 (positive overtravel limit) and I/O 3 (negative overtravel limit) as general
inputs/outputs instead of being used as travel limits. To set all status bits in Word 0 as general
inputs/outputs, enter EIGN(W,0).

NOTE: You can either type the command in the white text box or type the command directly in the
blue area of the terminal screen and then click Send or press Enter.

The active and asserted bits are cleared, as shown in the next figures.

EIGN Command Entered Active and Asserted Bits Cleared

To clear the historical fault bits, enter ZS. All remaining fault bits are cleared, as shown in the next
figures.

ZS Command Entered Remaining Bits Cleared
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Moving the SmartMotor

Moving the SmartMotor
NOTE: In addition to the software information in this section, there is context-sensitive help
available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

The SMI software contains a Torque mode that is used to test the motor response and ensure the drive
is operating properly.

This procedure assumes that:
l The SmartMotor is connected to the computer. For details, see Connecting the System on page
30.

l The SmartMotor is connected to a power source. For details, see Understanding the Power
Requirements on page 28 and Connecting the System on page 30.

l The SMI software has been installed and is running on the computer. For details, see Installing
the SMI Software on page 23.

l The SmartMotor has been detected and addressed. For details, see Detecting and
Communicating with the SmartMotors on page 40.

l The Drive Enable input must be connected and activated with 24V. For the input location, see
Motor Connectors and Pinouts on page 31.

l The overtravel limits and fault bits have been cleared. For details, see Checking and Clearing the
Status Bits on page 45.

Making the Motor Move

WARNING: The larger SmartMotors can shake, move quickly and exert great force.
Therefore, proper motor restraints must be used, and safety precautions must be
considered in the workcell design (see Other Safety Considerations on page 8).

To make the SmartMotor move:

1. In the Terminal window, select the tab that matches the communications channel to which your
motors are connected. To do this, look at the Configuration window, find the channel where the
motors are listed and click that tab name in the Terminal window.

Tab Selected that Matches the Communications Channel

NOTE: If you do not have the correct tab selected, the commands you enter will not go to the
motors and there will be no response.
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Setting and Reporting Torque

2. Enter these commands in the Terminal window:

You should immediately see the motor shaft moving in the positive direction (clockwise, when
looking at the end of the motor shaft). If the motor does not respond to the commands, see
Troubleshooting on page 62 for troubleshooting tips.

NOTE: Macros (shortcut keys) can be used to simplify entry of frequently-used commands.
For details, see Macros in the SmartMotor™ Developer's Guide.

3. After you have observed the motor shaft turning, enter the X command to decelerate the motor
to a stop.

Setting and Reporting Torque
The commands in this section are related to the previous motion procedure. For more details on these
commands, see the SmartMotor™ Developer's Guide.

MT (Mode Torque)

MT sets the mode of operation to torque mode. In this mode, the SmartMotor shaft applies a torque
independent of position. For more details, see Torque Mode in the SmartMotor™ Developer's Guide.

T=formula (Set Target Torque)

T can be set to any value from -32767 to +32767, which represents -99.99% to +99.99% PWM (pulse-
width modulation) commanded.

RTRQ (Report Actual Torque)

Enter RTRQ at the Terminal window to report the commanded torque from the trajectory generator.

Note that RTRQ typically reports a value that's one less than the T value. In the previous example,
T=3000, but RTRQ reports 2999. The value returned by TRQ (and RTRQ) will typically be one less than
the T (torque) value due to internal calculations. It may also be reduced in cases where the motor’s
output is in limitation. TRQ represents the output effort of the motor in both MT (torque mode) and
servo modes (MV, MP, etc.). Therefore, it provides a seamless transfer across those modes without
causing a ripple or bump in force to the load.

TS (Set Torque Slope)

The TS command defines how fast the processor applies a change in torque. For an example of the
TS command, see the Chart View Example in the SmartMotor™ Developer's Guide.

Torque slope can range from -1 to 2147483647 (default). At a value of 65536, the processor changes
torque by a value of 1 for each PID sample. The default sample rate is 16000; you can view the current
sample rate with the RSAMP command.

NOTE: If you're moving from a Class 5 to a Class 6 SmartMotor, the faster Class 6 sample rate
means the torque slope operates twice as fast in real-world time.
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Checking the Motor Position

Checking the Motor Position
There are several ways to check the motor position:

l Report the position using commands from the Terminal window

l View the position in the Motor View tool

These two methods are described in the next sections. You can also view the position in the Monitor or
Chart View software tools. For details, see SMI Software Features in the SmartMotor™ Developer's
Guide.

This procedure assumes that:
l The SmartMotor is connected to the computer. For details, see Connecting the System on page
30.

l The SmartMotor is connected to a power source. For details, see Understanding the Power
Requirements on page 28 and Connecting the System on page 30.

l The SMI software has been installed and is running on the computer. For details, see Installing
the SMI Software on page 23.

l The SmartMotor has been detected and addressed. For details, see Detecting and
Communicating with the SmartMotors on page 40.

l The overtravel limits and fault bits have been cleared. For details, see Checking and Clearing the
Status Bits on page 45.

Viewing the Motor Position with a Report Command
To report the motor position, in the Terminal window, issue the RPA (Report Position Actual) command:

RPA

The terminal responds with the current position of the motor:

RPA 3593657

NOTE: The position is reported on the same line as the command; there is no line feed or carriage
return for "report" commands.

The RPA command reports the actual motor position at the time the command was issued. Therefore, it
is just a "snapshot"—if the motor is moving, the reported position is not dynamically updated.

Viewing the Motor Position with the Motor View Tool
The Motor View tool provides another way to view the motor position. The advantage of using this tool
is that the position is dynamically updated when the motor is moving.
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Viewing the Motor Position with the Motor View Tool

To open the Motor View tool, from the SMI software Configuration window, right-click the motor you
want to view and select Motor View from the menu.

Opening the Motor View Tool

After the Motor View window opens, click the Poll button to begin polling (getting information from)
the motor. After polling begins, the motor position is shown in the Position box.

Motor View Tool Showing the Motor Position

Moog Animatics Class 6 M-Style SmartMotor™ Installation and Startup Guide, Rev. K

Page 51 of 64



Connectors, Pinouts and Examples

Connectors, Pinouts and Examples
This chapter provides information on the Class 6 SmartMotor connector pinouts and specifications. It
also provides example I/O connection diagrams. For information on connecting the motors, see
Connecting the System on page 30.

Class 6 M-Style Connector Pinouts 53

Class 6 I/O Connection Examples 54

Moog Animatics Class 6 M-Style SmartMotor™ Installation and Startup Guide, Rev. K

Page 52 of 64



Class 6 M-Style Connector Pinouts

Class 6 M-Style Connector Pinouts
The table below shows the pinouts for the connectors on the Class 6 M-style SmartMotors.

NOTE: In the table, I/O pins 5 and 6 OUTPUTS apply to MT2 motors only.
PIN Main Power Notes: P1
1 Control Power In +24 V (±20%), 32 V Max Also Supplies I/O
2 Chassis Ground
3 Common Ground

(Req’d. Ground)
Nonisolated

4 +24 V Min, 48 V Max

PIN Communications Connector Notes: P2
1 Control, Com, I/O and Amp Ground Common Ground Nonisolated

M12 8-Pin
Female End View

2 RS-485 B, Com ch. 0
3 RS-485 A, Com ch. 0
4 Encoder A+ Input/Output

5 Encoder B- Input/Output

6 Encoder A- Input/Output

7 +5V Out 50 mA Max
8 Encoder B+ Input/Output 125 KHz Individual Line

Frequency

PIN 24V I/O Connector Notes: P3
1 IN0 GP, also Analog Input  

M12 12-Pin
Female End View

2 IN1 GP, also Analog Input   

3 IN2 Pos Limit or GP

4 IN3 Neg Limit or GP

5
6
7 IN6 GP, G Cmd, or Homing Input

8 IN7 Drive Enable

9 OUT8 Brake or GP

10 OUT9 Not Fault or GP

11 +24 VDC Out (supplied from P1, Pin 1) 12.5 V Min, 23 V Max Load
2 Amps Max.

12 Ground Common Common Ground Nonisolated

PIN Industrial Ethernet Connectors Notes: P4

1 +TX

M12 4-Pin

2 +RX
3 -TX
4 -RX

EtherNet/IP, EtherCAT
+TD
+RD
-TD
-RD

Power Input

Industrial EtherNet

Communications24V I/O

EtherCAT=Input (L), Output (R)

For Inputs: 

Low Lvl Thld: 3.6 V Max 

High Lvl Thld: 5.0 V Min 

Inp Hysteresis: 1.0 V Min 

EtherCAT=100BASE-TX
10/100BASE-T

Analog Input Scale: 10 V FS  

M16 4-Pin Male

7 Configurable Inputs 

Specifications:

Specifications:

Specifications:

Specifications:

PROFINET Shield tied to motor housing

CAUTION: Exceeding 32 VDC into control power on any of the +24 V 
pins may cause immediate damage to the internal electronics. Ex-
ceeding a sustained voltage of 48 V to pin 4 of the P1 Power Input 
may cause immediate damage to the internal electronics. Exceed-
ing these voltage limits will void the warranty.

CAUTION: M-style connectors must be finger tightened only! DO 
NOT use a tool. Doing so can cause overtightening of the connec-
tion, which may damage the connector and will void the warranty.

CAUTION: For -IP option (IP sealed) motors, whenever the micro 
USB/SD cover is removed, the seal must be inspected and the 
cover must be reinstalled without damaging the seal in order to 
maintain the integrity of the sealed motor.

Chassis Ground Only Not Connected to Common
Control, Com, I/O and Amplifier Ground

Amplifier Power In Powers Amplifier Only

Configurable as Encoder
Output

NOTE: All specifications are subject to change without notice. Consult the factory for the latest information.

IN/OUT4*

IN/OUT5*

Micro USB/SD 
Cover

 GP or Ext. Enc. Index Capture

 GP or Int. Enc. Index Capture

115.2 KBaud Max

125 KHz Individual Line

Frequency

Inp Impedance > 10 kohm

250 mAmps Max For Outputs: Do not exceed
500 mAmps combined

Configurable as Encoder
Output

*Output available only on MT2 motors.
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Class 6 I/O Connection Examples

Class 6 I/O Connection Examples
These figures show I/O connection examples for the Class 6 motors. See the Notes at the end of this
section. Also, refer to Class 6 M-Style Connector Pinouts on page 53 for connector specifications. As
noted previously, connector and LED positions are the same for MT2 motors.

5

6

Enc B-

Enc A-

1 GND Common
COMMUNICATION

PIN FUNCTION

1   GND-COMMON
2   RS-485B CH0
3   RS-485A CH0
4   ENC  A+  IN
5   ENC  B-  IN
6   ENC  A-  IN
7   5 VDC OUT
8   ENC  B+  IN

Differential Output

A-
B- A+Gnd

B+

Optical
Encoder

8 Enc B+

4 Enc A+

NOTE: In the next figures, I/O pins 5 and 6 OUTPUTS apply to MT2 motors only.

4

IN 2 / Pos Limit

IN 3 / Neg Limit

Pos / Right Limit (Dry Switch)

Neg / Left Limit (Dry Switch)

3

2

5

11

IN-1

IN-4

24VDC Out (see Notes)

Momentary Switch

PNP

Sense

I/Os

PIN FUNCTION

1   IN0
2   IN1
3   IN2/POSLIMIT
4   IN3/NEGLIMIT
5   IN/OUT4

6   IN/OUT5

7   IN6

8   IN7-DRVEN
9   OUT8/BRAKE
10   OUT9-NOFAULT
11   24 VDC OUT**
12   GND

PNP Switch

**2 amps max.

1

2
3

4

5

6
7

8

9

10

11

12

1

2

3

4

5

6

7

8

12-Pin I/O 8-Pin COM
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Class 6 I/O Connection Examples

NOTE: I/O is Sourcing type (PNP)

4

3

2

5

6

7

8

9

10

11 +24VDC OUT

12 Ground

1

–  LOAD +

+

–

+

–

1

2

3

4

5

6

7

8

9

10

11

12

IN-0 GP, also Analog Input 

IN-1 GP, also Analog Input 

IN-2 Pos Limit or GP

IN-3 Neg Limit or GP

IN/OUT-4 GP or Ext. Enc. Index Capture

IN/OUT-5 GP or Int. Enc. Index Capture

IN-6 GP, G Cmd, or Home Input

IN-7 Drive Enable

OUT-8 Brake or GP

OUT-9 NOT FAULT

+24 VDC Out

GND-Common

PIN

I/Os

DESCRIPTION

Analog Output 

Sensor

Analog

Potentiometer

Class 6 M-Style Analog Pot and Sensor

Output

Input

Input

Input

Input

NOTE: Be sure that voltage drop across the potentiometer is appropriate for the rated wattage of
the potentiometer, i.e., Watts = Voltage2 / Ohms. For example, at 24 VDC and using a 10 kohm pot:
V2/R = 0.06 Watts.

NOTES:
I/O TYPE

The Class 6 motor I/O is Sourcing type (PNP).

DRIVE ENABLE

The Drive Enable input (pin 8) must be satisfied in order for the motor to turn.

24 VOLTS DC POWER

Do not use the motor as a power source for 24 VDC loads at pin 11 of the I/O connector.
l If you supply control power on the main connector, the I/O connector should not be a feed
through for loads, and the I/O devices should be sourced from an external power supply.

l Loads on specific outputs are allowed (when within the described limits).

DIFFERENTIAL ENCODER

The Differential Encoder inputs use the standard RS-485 chipset:
l If a true differential output TTL encoder is used, just wire A and B signals as labeled.

CAUTION: NO differential encoder signals higher than 5V TTL should be used!

+5 VDC PIN

The +5 VDC pin can only source 50 mA and is meant for RS-485 biasing only. If it is used to power an
external 5V TTL encoder, the device must not draw more than 50 mA max.
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Class 6 I/O Connection Examples

ENCODER OUTPUT

For Class 6 M-style motors, the internal encoder is conditioned with error correction and resolution
adjustments when used normally for positioning (i.e., as seen in the RPA command “actual position”).
However, when directed as an output and received into another motor for the purposes of follow mode,
there are several things to be aware of at the receiving motor:

l The resolution seen at the receiving motor will be 4096 instead of 4000. MFMUL and MFDIV will
need to compensate accordingly.

l The direction will be negative (assuming a straight-through connection of the 8-pin “Y” cable).

l There are non-accumulating, single-turn errors that are not compensated.
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Other Class 6 M-Style Changes

Other Class 6 M-Style Changes
This chapter provides information on getting started with your SmartMotor.

EOBK(IO) Command Limitations 58

Ethernet Error, Status Word 2 Bit 6 58

I/O Control Details 58

I/O Control Examples 59

Scale Factor Calculation – Sample Rates 59

Commands for Class 6 60

Commands That Have Changed 60

Commands Not Supported 61

Commands Supporting the DS2020 Combitronic System 61

Features not Available in Class 6 M-Style 61
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EOBK(IO) Command Limitations

EOBK(IO) Command Limitations
The EOBK(IO) command configures the specified SmartMotor output to control an external brake.
However, only output 8 works for the Class 6 M-style SmartMotor. Therefore, the valid EOBK(IO)
values are:

l EOBK(8) to enable

l EOBK(-1) to disable

Ethernet Error, Status Word 2 Bit 6
The intent of Status Word 2 bit 6 is to inform the user that one or more errors has occurred through
the Ethernet interface. To determine the specific error that has occurred, consult the RETH command
description in the corresponding fieldbus guide.

I/O Control Details
The SmartMotor fieldbus guides describe the details of accessing I/O for each communication protocol.
The SmartMotor™ Developer's Guide describes I/O control details for RS-485 communications.

In a local program or serial command, the OR, OS and OUT commands are the same as Class 5. For
details, see the SmartMotor™ Developer's Guide.

For the Class 6 M-style SmartMotor, it is important to note which are inputs, which are outputs, and
which have special functions. For those details, refer to the next table.
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I/O Control Examples

Logical
I/O

Number

Input or
Output

Possible
(Selectable)
Functions

Default Operation

0 Input only General purpose, discrete
or analog General purpose

1 Input only General purpose, discrete
or analog General purpose

2 Input only Positive limit, or general
purpose Positive limit

3 Input only Negative limit, or general
purpose Negative limit

4 Input/Output*
General purpose, or index
capture for external
encoder

General purpose

5 Input/Output*
General purpose, or index
capture for internal
encoder

General purpose

6 Input only General purpose, G com-
mand, or homing input General purpose

7 Input only Drive enable Drive enable

8 Output only Brake or general-purpose
output Brake output

9 Output only Not fault or general pur-
pose output Not fault output

*This Output is only available on the Class 6 MT2 SmartMotor.

I/O Control Examples
To make output 8 a general-purpose output:

EOBK(-1) 'Disables brake output from any I/O pin
OR(8) 'Clears output (0 V)
OS(8) 'Sets output (24 V)
EOBK(8) 'Restores output 8 to brake function

To read inputs:

x=IN(W,0,15) 'Reads inputs 0,1,2,3 as bitfield stored into variable x
EIGN(2) 'Disables positive limit, makes a general-purpose input
EIGN(3) 'Disables negative limit, makes a general-purpose input
EILP 'Re-enables positive limit
RIN(3) 'Reads input 3

Scale Factor Calculation – Sample Rates
The sample rate for Class 6 SmartMotors is fixed at 16,000 Hz (16 kHz).
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Commands for Class 6
The commands in this section were added for the Class 6 SmartMotor.

NOTE: These commands are not available for the Class 5 SmartMotor.

EOFT: Configure a specified output for the fault indication.

GROUP(function,value): Configure group addressing settings of the Combitronic over Ethernet (UDP)
communications.

IDENT=, RIDENT, x=IDENT: Set the IDENT value which is useful for user programs to detect which axis
they are. Report, use in expression, or assign the value of IDENT to a user variable.

IPCTL(action,"string"): Sets IP address, Mask, or Gateway:
action= 0, set IP address; 1, set Mask; 2, set Gateway;
"string": formatted as an IP address and entered as a string;
e.g., IPCTL(0,"192.168.0.10") sets IP address to 192.168.0.10

PRINT0: Explicitly outputs to the COM 0 serial port.

PRINT8: Explicitly outputs to the USB port.

RGROUP(function): Report group addressing setting of the Combitronic over Ethernet (UDP)
communications.

RSP5: Reports network interface card firmware version.

RUSB(arg), x=USB(arg): Report the value of the specified USB status word (specified by arg) or assign
it to a variable.

RUSB, x=USB: Report the value of USB status word 0 or assign it to a variable.

SNAME("string"): Sets a unique PROFINET station name. See the Class 6 SmartMotor™ PROFINET
Guide.

For details on these commands, see the SmartMotor™ Developer's Guide.

These Industrial Ethernet (IE) commands were added for the Class 6 SmartMotor:

NOTE: These commands are not available for the Class 5 SmartMotor.

RETH(arg), x=ETH(arg): Assign result to a variable or report errors and certain status information for
the EtherCAT or PROFINET bus. See the corresponding fieldbus manual for arg values.

ETHCTL(action,value): Controls network features. See the corresponding fieldbus manual for details.

For details on these commands, see the Class 6 SmartMotor EtherCAT Guide or the Class
6 SmartMotor™ PROFINET Guide.

Commands That Have Changed
These commands have been modified for the Class 6 M-style SmartMotor:

PRINT: Corresponds with the value of STDOUT, which is 8 (USB port) by default. Note that this
behavior is different than in Class 5 motors.

STDOUT=8: (Default) Sets internal report commands to the USB port.

For details on these commands, see the SmartMotor™ Developer's Guide.
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Commands Not Supported

Commands Not Supported
These commands are not supported in the Class 6 M-style SmartMotor:

CAN related: CADDR=, CANCTL, CBAUD=, RCADDR, RCAN, RCBAUD

Sync motion commands: (require Combitronic, see the next note) ADTS, ATS, DTS, GS, PRTS, PRTSS,
PTS, PTSS, RPTSD, RPTST, TSWAIT, VTS

NOTE: The sync motion commands are available on the -EIP option Class 6 M-style SmartMotor with
the netX 52 processor, NXF EIP version 3.4.0.5 or later, and SmartMotor firmware 6.0.2.35 or later,
as those motors do support Combitronic technology over Ethernet.

Commands associated with the second serial port or other hardware that is not available in the Class 6
M-style motors: BAUD(1)=, CCHN on channel 1, ECHO1, ECHO_OFF1, OCHN on channel 1, PRINT1,
RBAUD(1), RGETCHR1, RLEN1, ROC, ROF, SILENT1, SLEEP1, TALK1, WAKE1,

Other: ENCCTL, ENCD, EOIDX, MDH, MDHV, MDT, OC, OF, PID, SCALEA, SCALEP, SCALEV

Commands Supporting the DS2020 Combitronic System
Note that the Class 6 M-style motors do not support the DS2020 Combitronic system. Therefore, any
commands specific to that product are not available on these motors.

For details on the commands for the DS2020 Combitronic system, see the topic "Commands for
DS2020 Combitronic" in the SmartMotor™ Developer's Guide.

Features not Available in Class 6 M-Style
These features are not implemented:

l CAN bus communications

l Combitronic communications (only available on properly equipped -EIP option motors)

l DeviceNet protocol

l PROFIBUS protocol

l I²C communications

l AD1 option
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Troubleshooting
This section provides troubleshooting information for common problems. For additional support
resources, see: http://www.animatics.com/support.html.

Issue Cause Solution
Communication and Control Issues
Motor control power light
does not illuminate.

Control power is off,
disconnected or incorrectly
wired.

Check that control power is connected to the proper pins
and turned on. For connection details, see Connecting the
System on page 30.

Motor does not communicate
with SMI.

Transmit, receive or ground pins
are not connected correctly.

Ensure that transmit, receive and ground are all
connected properly to the host PC.

Motor program is stuck in a
continuous loop or is disabling
communications.

To prevent the program from running on power up, use
the Communications Lockup Wizard located on the SMI
software Communications menu.

Motor disconnects from SMI
sporadically.

COM port buffer settings are too
high.

Adjust the COM port buffer settings to their lowest
values. This is done In the Windows Device Manager>
Advanced Settings dialog box for the associated COM
port driver.

Poor connection on cable from
motor to PC.

Check the cable connections and/or replace it.

Power supply unit (PSU)
brownout.

PSU may be undersized for the application, which causes
it to brown-out during motion. Make moves less
aggressive, increase PSU size or change to a linear
unregulated power supply.

Motor stops communicating
after power reset, requires
redetection.

Motor does not have its address
set in the user program.
NOTE: Serial addresses are lost
when motor power is off or
reset.

Use the SADDR or ADDR= command within the program
to set the motor address.

Red PWR SERVO light
illuminated.

Red LED indicates the drive
stage is OFF. This may be due to
never having been turned on yet,
or a critical shaft protection
fault.

To discover the source of the fault, use the Motor View
tool located on the SMI software Tools menu.

Motor doesn't turn. Faults not cleared and/or drive
enable not satisfied.

Clear faults (see Checking and Clearing the Status Bits on
page 45).
Satisfy the drive enable input (see Drive Enable Input on
page 29).

Common Faults
Bus voltage fault. Bus voltage is too high for

operation.
Check servo bus voltage. Check for excessive
regenerative energy from motor due to no/insufficient
shunt resistor.

Bus voltage is too low for
operation.

If motor uses the dual-power configuration (separate
drive and control power supplies), ensure that both power
supplies are connected and are sized correctly for the
motor.

Overcurrent occurred. Motor intermittently drew more
than its rated level of current.
Does not cease motion.

Consider making motion less abrupt with softer tuning
parameters or lower acceleration profiles.

Excessive temperature fault. Motor has exceeded internal PCB
temperature limit of 85°C. Motor
will remain unresponsive until it
cools down below 80°C.

Motor may be undersized or ambient temperature is too
high. Check motor sizing for the application in terms of
continuous rating. Consider adding heat sinks or forced
air cooling to the system.
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Issue Cause Solution
Excessive position error. The motor's commanded position

and actual position differ by
more than the user-supplied
error limit.

Increase error limit, decrease load or make movement
less aggressive. Also, ensure you are not voltage limited
for the torque at speed required. If running from less
than 48 VDC, check ratings for lower bus voltages and
ensure the motor is within required torque capacity.

Motor faults on position error
only after a certain amount of
time.

Motor sized incorrectly. Check motor sizing for the application in terms of
continuous rating. Also, ensure you are not voltage
limited for the torque at speed required. If running from
less than 48 VDC, check ratings for lower bus voltages
and ensure the motor is within required torque capacity.Motor is not accurately

corresponding to trajectory.
Historical positive/negative
hardware limit faults.

A limit switch was tripped in the
past.

Clear errors with the ZS command.

Motor does not have limit
switches attached.

Configure the motor to be used without limit switches by
setting their inputs as general use.

Programming and SMI Issues
Several commands not
recognized during compiling.

Compiler default firmware
version set incorrectly.

Use the Compiler default firmware version option in the
SMI software Compile menu to select a default firmware
version closest to the motor's firmware version. In the
SMI software, view the motor's firmware version by
right-clicking the motor and selecting Motor Properties.

For Further Information...
Now that your SmartMotor is installed and operating, the next step is to learn about its features,
commands and programming in order to create a useful application.

Information on SMI software features, SmartMotor programming, communications, motion control and
more is provided in the SmartMotor™ Developer's Guide. That guide also includes a complete
SmartMotor command reference, and an Appendix of other related topics that are useful during
application development.
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